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Preface 
This preface contains the following topics:
• “About this guide” on page vi
• “Accessing user guides” on page viii
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

What this guide covers

This guide describes the Bravo On-Deck Thermal Cycler (ODTC) accessory, including:
• ODTC components
• How to set up the Bravo ODTC in the VWorks software

Table Terms used in this guide

Job role Responsibilities

Integrator Someone who writes software and configures hardware 
controlled by VWorks Automation Control.

Lab manager, 
administrator, or 
technician

Someone who is responsible for:
• Developing the applications that are run using VWorks 

Automation Control
• Developing training materials and standard operating 

procedures for operators

Operator Someone who performs the daily production work using 
VWorks software and solves routine problems.
Your organization may choose to create its own procedures 
for operators including the procedures in this guide.

Term Description

VWorks Automation Control VWorks software component that you use to create 
the protocols that run your automation devices.

VWorks Plus The compliance-enabled workstation edition of the 
VWorks software. This edition includes VWorks and 
OpenLab Control Panel, Shared Services, Content 
Management, and Content Browser installed on a 
single computer.

VWorks Standard The workstation edition of the VWorks software that 
is not compliance enabled. This edition includes 
VWorks and OpenLab Control Panel and Shared 
Services installed on a single computer.

Content Management 
(OpenLab component)

The secure data storage repository for VWorks 
compliance-enabled editions.

Control Panel (OpenLab 
component)

The user interface for Shared Services.



vii

Preface
About this guide

Bravo ODTC (On-Deck Thermal Cycler) User Guide

 

What is new in this edition

Software version

The Bravo ODTC requires the following software:
• VWorks software 14.2, which runs on the Microsoft Windows 10 64-bit operating 

system, or VWorks software 14.3, which runs on the Microsoft Windows 10 or 
Windows 11 64-bit operating system.
The SiLA XMLRPC Server, which is required, is installed with VWorks 14.2 and later.

• Inheco ODTC Script Editor 3.0.1
• Inheco ODTC Device Manager 1.1.0

Related guides

Inheco ODTC manuals
• Inheco ODTC User and Installation Manual. Includes safety guidelines and 

maintenance procedures for the ODTC.
• Inheco ODTC Device Manager User’s Manual. Describes how to connect to the 

ODTC and control it using the ODTC Device Manager utility, including how to 
upload the methods to the ODTC.

• Inheco ODTC Script Editor User’s Manual. Describes how to create ODTC 
temperature initialization steps (pre-methods) and methods, and how to create an 
xml file for uploading the methods to the ODTC.

Note: Inheco user documentation is supplied with the ODTC on a USB drive.

VWorks and Bravo guides
• Bravo Platform Site Preparation Checklist. Describes the prerequisites for installing 

the Bravo Platform, including the computer requirements.
• G5562A, G5563A Bravo Platform Safety and Installation Guide. Includes the safety 

guidelines and installation procedures for the Bravo Platform.
• Bravo Platform User Guide. Describes the Bravo components, how to set up and 

troubleshoot the Bravo Platform and accessories.

Microsoft Control Panel Part of the Microsoft Windows operating system.

Shared Services (OpenLab 
component)

Set of administrative services that control VWorks 
user access and file storage. Shared Services are 
accessed via the Control Panel.

Term Description

Updates See...

Added the parameter 
Min Y range to the 
ODTC configuration

“Configuring ODTC in Bravo profile” on page 21 
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• VWorks Automation Control Installation Guide. Describes how to use the VWorks
software to set up devices, write protocols and create forms, run protocols, and
troubleshoot problems.

Accessing user guides

About this topic

This topic describes the different formats of user information and explains how to 
access it for the Agilent Automation Solutions products.

Where to find user information

The user information is available in the following locations:
• Knowledge base. The help system for the Automation Solutions products is

available from:
– Help menu within the VWorks software: Select Help > Knowledge Base or press

F1.

– From the Windows desktop: Select Start ( ) > All Apps > Agilent 
Technologies > VWorks Knowledge Base.

For guidelines on using the VWorks context-sensitive help and knowledge base 
features, see Using the knowledge base, below.

• PDF files. The PDF files of the user guides are installed with the VWorks software
(C:\Program Files (x86)\Agilent Technologies\VWorks\UserGuides) and are
available in the VWorks Knowledge Base.

• Website. You can search the online VWorks Knowledge Base or download the latest
version of any PDF file from the Agilent website at
https://automation.help.agilent.com.

Accessing safety information

Safety information for the Agilent Automation Solutions devices appears in the 
Automation Solutions Products General Safety Guide and in the corresponding device 
safety guide or user guide.
You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as Microsoft 
Edge.
Note: If you want to use Microsoft Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). For 
instructions, see the Microsoft user documentation.

https://automation.help.agilent.com
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . The pointer 

changes to . Notice that the different icons or areas are highlighted as you 
move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

Item Description

1 Contents pane. Lists all the books and the table of contents of the books.

2 Tabs. Allows you to search the Knowledge Base by product type.

3 Topic area. Displays content of selected tab or topic. In the above example, the content of the Home 
tab is displayed in the topic area.

4 Search bar. Enables you to search the entire knowledge base for a word or term.

5 Navigation buttons. Enable you to navigate through the next or previous topics listed in the Contents 
pane.

6 Print button. Enables you to print the information in the topic area.
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1 Introduction
This chapter contains the following topics:
• “About the safety guidelines” on page 2
• “Bravo ODTC accessory overview” on page 3
• “Primary hardware components” on page 5
• “Software components” on page 9
• “Labware requirements” on page 10
• “About ODTC environmental and technical specs” on page 11
• “Installation overview” on page 12
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About the safety guidelines

Bravo ODTC

WARNING
Failure to understand the Inheco ODTC safety instructions can expose you to 
hazardous voltage, crushing, and burning hazards, resulting in injury and product 
damage. Before using the Bravo ODTC, make sure you are aware of the potential 
hazards and understand how to avoid being exposed to them.

Ensure you have read the Safety Instructions section of the Inheco ODTC User and 
Installation Manual and are trained in the safe operation of the device to limit your 
safety risk during operation of the ODTC.

Bravo Platform

WARNING
Using controls, making adjustments, or performing procedures other than those 
specified in the user documentation can expose you to moving-parts hazards and 
hazardous voltage. Before using the Bravo Platform, make sure you are aware of the 
potential hazards and understand how to avoid being exposed to them.

Ensure you have read the safety guidelines in the G5562A, G5563A Bravo Platform 
Safety and Installation Guide and are trained in the safe operation of the device.
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Bravo ODTC accessory overview

Description

The Bravo On-Deck Thermal Cycler (ODTC) is an accessory that can be used to amplify 
a genetic target of interest in NGS or PCR sample preparation workflows. The 
amplification is achieved through heating and cooling biological samples under 
specified conditions. The Bravo ODTC is controlled by the VWorks software when 
integrated with a Bravo Platform.
For ODTC general and thermal specifications, see the Inheco ODTC User and 
Installation Manual.

Prerequisites for Bravo configuration

The following figure shows the ODTC accessory installed at Bravo deck location 2.

Figure Example of Bravo deck with ODTC installed at deck location 2 (top view)

The ODTC accessory requires the following Bravo configuration:
• Special Bravo deck with a cutout at deck location 2 for ODTC installation. The 

standard Bravo deck does not have the location 2 cutout.
Note: Deck location 5 is moved 5 mm forward to accommodate the size of the 
accessory at location 2. A short platepad is typically installed at location 5, as 
the figure shows.
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• Rear shield that accommodates the portion of the ODTC that extends beyond the 
deck at the rear.

• Slightly greater range of motion in the y-axis (front-to-back) and z-axis (vertical). 
• Deck risers to accommodate the below-deck height and air flow requirements of 

the ODTC accessory. 

Figure Bravo Platform with ODTC installed: front view (left) and rear view (right)

Bravo

ODTC front ODTC rear
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Primary hardware components

Bravo ODTC components

The Bravo ODTC accessory has the following components:
• Special Bravo deck with deck location 2 ODTC cutout and mounting brackets
• ODTC (On-Deck Thermal Cycler)
• Light curtain with rear shield modified for ODTC
• ODTC teach plate
The ODTC consists of the following primary components:

1 Thermal Cycler. The accessory that is installed at Bravo deck location 2 by an 
Agilent field service engineer.

2 Power & Control Unit (PCU). The external power supply and communication unit 
for the ODTC, which is installed next to the Bravo Platform. The PCU includes a 
power cord and Ethernet cable.

IMPORTANT
The power switch of the ODTC Power & Control Unit must be accessible to turn off 
power to the ODTC in case of emergency.

3 ODTC cable. The power and communication cable that is hardwired to the ODTC 
and connects to the ODTC Power & Control Unit.

The following sections provide detailed descriptions.

Thermal Cycler features

This section provides a summary of the Thermal Cycler features. For detailed 
descriptions of the ODTC features and technology, see the Inheco ODTC User and 
Installation Manual. 

Figure Thermal Cycler features
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Item Component Description

1 ODTC door 
(also known as lid) 

The door that slides open and closes horizontally during normal operations. 

Figure ODTC door closed

 
The VWorks software controls the automated opening and closing of the door.
Note: For maintenance procedures and to install the optional Sealing Cover, 
the door can be opened manually to a 90º position. For instructions, see the 
Inheco ODTC User and Installation Manual.

2 Plate mount  
(also known as 
Vapor Chamber 
Mount or VCM) 

The plate stage that enables optimized heat transfer into a PCR plate.

3 Optional 
ODTC Sealing 
Cover (not shown)

The removable interior cover that can be mounted on the inner surface of the 
ODTC door. The Sealing Cover is included in the Bravo shipment but not 
installed by the Agilent field engineer.

IMPORTANT Agilent recommends using disposable automation lids or 
presealed plates instead of the ODTC Sealing Cover to avoid potential cross-
contamination and to eliminate the need to clean the cover after every run. 

For details on the Sealing Cover and instructions on how to install it, see the 
Inheco ODTC User and Installation Manual.

4 Status LED The ODTC front panel status light, which is visible below the Bravo deck. The 
LED displays the following status:
• Green steady light – device is ready for operation
• Green flashing light – initialization, self-test, or not ready yet
• Red steady light – malfunction
• Red flashing light – malfunction of mini PC on the main board of the 

Power & Control Unit.
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CAUTION
The free air supply for the Thermal Cycler inlet must be ensured to prevent 
malfunction caused by insufficient cooling. Do not cover the ventilation inlet or 
exhaust outlet at any time and keep the air inlet clean.

CAUTION
Ensure that the area below the Bravo deck is clear of any obstacles that could 
restrict the airflow. Do not store any objects below the Bravo deck.

ODTC Power & Control Unit

The Power & Control Unit is the external power supply and communication unit for the 
ODTC.

The following figure shows the features on the rear panel. The main power switch 
(figure, item 3) must always be accessible to turn off power to the ODTC in case of 
emergency.

Figure Power & Control Unit (rear view)

5 Ventilation inlet The ODTC front panel air inlet that is located below the Bravo deck.

6 Exhaust outlet (not 
shown)

The outlet that exhausts the warm air from the bottom of the ODTC 
underneath the Bravo deck. 

Item Component Description

1 2       3              4      5                 6       7

Item Component Description

1 Fuses Houses the AC inlet fuses 

2 AC power entry Connects the power cord from the Power & Control Unit to an AC outlet with a 
grounded circuit.
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CAUTION
The free air supply for the ODTC Power & Control Unit must be ensured to prevent 
malfunction caused by insufficient cooling. Do not cover the ventilation inlets or 
exhaust outlet at any time and keep the ventilation inlets clean. 

For a detailed description of the ODTC hardware components, see the Inheco ODTC 
User and Installation Manual.

3 Power switch Turns on (I) and off (O) the AC power.

4 Micro-SD card slot Contains a Micro-SD card. This SD card is used for storing log files. 

IMPORTANT Do not remove the SD-card. It is necessary for proper 
operation of the device.

5 Ethernet connector 
with 2 Status LEDs

Connects the Power & Control Unit to the controlling computer via an Ethernet 
switch.
The LEDs provide the following status:
• Left LED orange – Ethernet connection is okay.
• Right LED steady green – Device is ready for operation.

6 ODTC connector Connects the Power & Control Unit to the power and communication cable 
from the Thermal Cycler.

7 Ventilation outlet The outlet located on the back of the unit that exhausts the heated air.

8 Ventilation inlets The air inlets that are located on the front of the Power & Control Unit, as the 
following figure shows.

Item Component Description
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Software components

Required software

Agilent VWorks Automation Control software
The VWorks software is a combination of Agilent OpenLab and VWorks components 
that provide the user management and instrument control for the Bravo Platform. The 
software is available in the following editions.

The VWorks software includes the tools to create labware definitions and liquid 
classes, set up devices, create device profiles, and create and run protocols. 
Bravo Diagnostics is plugin software that you open from within VWorks. You use Bravo 
Diagnostics to create a device profile that includes the configuration of the ODTC 
accessory.

SiLA XMLRPC Server 
The SiLA XMLRPC Server is the communication interface between the ODTC device 
and the VWorks software. The SiLA XMLRPC Server must be running in order for 
VWorks software to control the ODTC device.
The VWorks installation wizard installs the SiLA XMLRPC Server.

Inheco ODTC Script Editor 
The ODTC Script Editor is required to create the pre-methods and methods 
(temperature profiles) to be run on the ODTC. These methods must then be uploaded 
to the individual ODTC device using the ODTC Device Manager before they are available 
to the VWorks software.
Note: Any other ODTC process steps, such as open door and close door, are controlled 
by the VWorks software via the SiLA XMLRPC Server.
For details, see the Inheco ODTC Script Editor User’s Manual.

Inheco ODTC Device Manager
The ODTC Device Manager enables the uploading of the methods created using the 
Script Editor to the ODTC device. 
For details, see the Inheco ODTC Device Manager User’s Manual. 

VWorks edition File storage type Compliance 
enabled?

VWorks Plus Content Management 
Note: A system or VWorks administrator can use 
the Content Browser to view and edit the project 
structure and contents at  
/VWorks Projects/VWorks/

Yes

VWorks Standard Local file system
Note: Any user can access the project files directly 
using the Windows File Explorer at C:\OLSS 
Projects\VWorks Projects\VWorks\

No
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Software terminology

Labware requirements

The following table lists labware that is compatible with the Bravo ODTC. The VWorks 
software includes the corresponding labware entries, which belong to both of the 
following labware classes: 
• Uses Standard Platepad
• Uses Thermal Cycler Platepad

Software terms Description

ODTC Script 
Editor

VWorks 

lid door The ODTC door that opens and closes horizontally under VWorks control. 

mount mount The ODTC Vapor Chamber Mount (VCM) where the VWorks software 
commands the Bravo Platform to pick and place microplates at the ODTC. 
The mount provides the interface that enables an optimized heat transfer 
into the microplate.

temperature 
initialization 
step

pre-method A method to set the ODTC mount and door to a defined start temperature. 
The ODTC tasks in the VWorks protocol specify which pre-method or method 
to run on the ODTC. For details, see “ODTC protocol tasks” on page 41.

method method Set of temperature steps (programming of simple temperature profiles). 
VWorks refers to ODTC methods and PCR profiles as methods.

PCR method

Labware
(VWorks labware entry)

Manufacturer and  
part number

96 Eppendorf Twin.tec PCR plates (full-skirted)
(96 Eppendorf Twin.tec PCR)

Eppendorf 951020401

Armadillo PCR Plate, 96-well, clear, clear wells (full-skirted)
(96 Armadillo PCR)

ThermoFisher Scientific 
AB2396 

Hamilton PCR Comfort Lid (disposable lid)* Hamilton 814300

* Agilent recommends using disposable automation lids or presealed plates instead of the ODTC Sealing 
Cover. 
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About ODTC environmental and technical specs

Refer to the Inheco ODTC User and Installation Manual for detailed ODTC environmental 
and technical specifications.

About ODTC thermal specifications
The ODTC temperature range is 4 °C to 99 °C. The operation of the ODTC below 
ambient temperature has to be limited to 1-2 hours per application. Depending on the 
humidity in the atmosphere, condensation will be generated when operating the ODTC 
below ambient temperature. 

CAUTION
Condensation might have an effect on the thermal performance and lifetime of the 
ODTC. Condensate can prevent the ODTC from operating properly and can damage 
the ODTC. 

After each use of the ODTC below ambient temperature a drying step needs to be 
performed. It can be part of a following method or should follow directly after the 
cooling period. The drying step needs to be clearly above ambient temperature. The 
length of the drying step depends on the amount of condensate and should be ended 
when no condensation is visible on the Mount or its surrounding.

Environmental conditions
The ODTC tolerates a narrower temperature and humidity range than the Bravo 
Platform.

Device Operating temperature (°C) Operating humidity

Bravo Platform 4 °C to 40 °C 10-90% Relative Humidity, 
non condensing

ODTC 15 °C to 32 °C 30-80% Relative Humidity, 
non condensing
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Installation overview

Agilent field personnel install the Bravo Platform with ODTC. This guide assumes that 
the Bravo On-Deck Thermal Cycler (ODTC) accessory and the controlling VWorks 
software have already been installed.
The following table presents an overview of the installation workflow for reference.

Step For this task... See...

1 Verify that the installation site meets the site requirements.

IMPORTANT Ensure that the laboratory table is not bowed 
and is perfectly flat and rigid. A bowed or wobbly table will 
cause placement errors during protocol execution.

Clear the table of all material that might interfere with the 
installation.

 Bravo Platform Site Preparation 
Checklist

2 Unpack the computer and ensure that it meets the computer 
specifications.

 Bravo Platform Installation 
Checklist

3 Unpack the Bravo Platform and accessories. 

IMPORTANT Do not remove the y-axis shipping stop from 
the head mount until after Bravo deck risers are installed.

Bravo Platform Unpacking Guide

4 Install the Bravo deck risers and then finish installing Bravo 
Platform.

IMPORTANT Ensure a short platepad is installed at deck 
location 5, which is directly in front deck location 2, where the 
Bravo ODTC will be installed.

G5562A, G5563A Bravo Platform 
Safety and Installation Guide

5 Install the ODTC accessory at deck location 2. Agilent field service

6 Set up the computer and install the software:
• VWorks software 14.2 (or later) and SiLA XMLRPC Server 
• Inheco ODTC Script Editor 3.0.1
• Inheco ODTC Device Manager 1.1.0

Agilent field service

7 Upload any provided pre-methods and methods to the Bravo 
ODTC.
The ODTC temperature profiles (pre-methods and methods) 
must be uploaded to the ODTC accessory using the ODTC 
Device Manager utility before the methods are available for 
use in the VWorks software. 
Note: The ODTC methods are created using Inheco ODTC 
Script Editor. For details, see the Inheco ODTC Script Editor 
User’s Manual.

Inheco ODTC Device Manager 
User’s Manual

8 Set up the Bravo Platform, including the teachpoints and the 
gripper y-axis offset.

Bravo Platform User Guide
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9 Configure the ODTC and set the ODTC teachpoint. “Setting up Bravo ODTC” on 
page 15

10 Install the Bravo shields and Light Curtain. G5562A, G5563A Bravo Platform 
Safety and Installation Guide

11 Verify the installation and setup. Agilent field service

Step For this task... See...
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2 Setting up Bravo ODTC
This chapter contains the following topics:
• “Setup workflow” on page 16
• “Starting up and shutting down” on page 17
• “Starting and stopping SiLA XMLRPC Server” on page 20
• “Configuring Bravo ODTC accessory” on page 21
• “Initializing the profile” on page 28
• “Setting the teachpoint” on page 29
• “Testing Bravo ODTC” on page 34
• “Setting the labware class” on page 37
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Setup workflow

The following table presents the workflow for setting up the Bravo ODTC accessory.

Step For this task... See...

1 Start up the Bravo Platform with 
ODTC.

“Starting up and shutting down” on 
page 17

2 Start the SiLA XMLRPC Server to 
enable VWorks communication with 
the Bravo ODTC.

“Starting and stopping SiLA XMLRPC 
Server” on page 20

3 Create the VWorks device file and 
Bravo profile.

Bravo Platform User Guide

4 Configure the ODTC accessory in the 
Bravo profile you created in step 3.

“Configuring Bravo ODTC accessory” 
on page 21

5 Initialize the profile in Bravo 
Diagnostics.

“Initializing the profile” on page 28

6 Set the teachpoint for the ODTC at 
Bravo deck location 2.

“Setting the teachpoint” on page 29

7 Use diagnostics to test the ODTC 
communication.

“Testing Bravo ODTC” on page 34

8 Set the labware class for the labware 
allowed on the ODTC at Bravo deck 
location 2.

“Setting the labware class” on 
page 37

9 Create a VWorks protocol that is 
linked to the device file you created in 
step 3.

VWorks Automation Control User 
Guide

10 Set the ODTC task parameters in the 
VWorks protocol.

• “ODTC Action (Agilent Bravo)” on 
page 42

• “ODTC Run Method (Agilent 
Bravo)” on page 46
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Starting up and shutting down

Starting up the Bravo Platform with ODTC

CAUTION
Always turn off the Bravo Platform before installing or uninstalling a liquid-handling 
head. Failure to do so can damage the head electronics.

To start up the Bravo Platform with ODTC:
1 Ensure that the main power and Ethernet cables are plugged into the Bravo 

connection panel.
2 At the ODTC Power & Control Unit, ensure that the power and communication 

cables are properly connected, and turn on the power switch.

Figure Power &Control unit (rear view)

The ODTC status LED light flashes green for up to a minute while the ODTC 
firmware is booting. The green light stops flashing and then remains lit. This light is 
located below the deck.
Note: The ODTC can respond to communication attempts, including 
initialization, only after the green light stops flashing.

Figure ODTC status LED location below Bravo deck (front view)

At the ODTC, the door slides open.
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Figure ODTC door open (top view)

3 Turn on any other Bravo accessories.
4 Turn on the computer and the monitor, and start the Microsoft Windows operating 

system.
5 If you have not already done so, install the liquid-handling head.
6 On the side of the Bravo Platform, press the power switch to the on (|) position.

The front panel status lights turn blue. 
Note: If the emergency-stop pendant is pressed or absent, the status lights will 
turn red. 
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7 Start the VWorks software:

On the Windows desktop, double-click the VWorks shortcut  and log in.

Note: If the VWorks menu bar or toolbars are hidden, right-click the VWorks 
window, and select the view options from the shortcut menu.

8 Start the SiLA XMLRPC Server. See “Starting and stopping SiLA XMLRPC Server” 
on page 20.

Shutting down the Bravo Platform with ODTC

Shut down the Bravo Platform before you:
• Clean the Bravo Platform
• Change the liquid-handling head 
• Install accessories
• Move the Bravo Platform

CAUTION
Always turn off the Bravo Platform before installing or uninstalling a liquid-handling 
head. Failure to do so can damage the head electronics.

To shut down the Bravo Platform:
1 If removing the liquid-handling head, ensure that the disposable tips are removed. 
2 Optionally, home the liquid-handling head.
3 Close the software and shut down the computer.
4 Turn off the ODTC and any other accessories.
5 If using an Auto Filling Reservoir, disconnect the bottles to prevent siphoning.
6 On the side of the Bravo Platform, press the power switch to the off (o) position.
7 If applicable, uninstall the liquid-handling head.
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Starting and stopping SiLA XMLRPC Server

The ODTC has a SiLA (Standardization in Laboratory Automation) communication 
interface. The SiLA XMLRPC Server must be running to enable VWorks communication 
with the Bravo ODTC device.

Starting the SiLA XMLRPC Server

To start the server:

1 On the Windows desktop, double-click the SiLA shortcut icon .

The SiLA XMLRPC Server opens.

2 Verify the settings. In most cases, you can use the default settings. 

3 Click Start server.
The Stop server button becomes available and the Start server button is grayed.

Stopping the SiLA XMLRPC Server

To stop the server:
In the SiLA XMLRPC Server window, click Stop server.

Setting Value
XML RPC Server Setting 

Port (1–65535)
6000 (default)
The corresponding value in the Bravo profile ODTC 
configuration must match this value.

TCP port numbers The SiLA Web Service port numbers.
Web service 8080 (default)
Event receiver 7071 (default)

SiLA device IP address 192.168.0.19 (default)
The static IP address for the ODTC.
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Configuring Bravo ODTC accessory

Before you start

VWorks administrator or technician privileges (advanced users) are required to create 
and manage profiles for the Bravo Platform.
VWorks Plus. The software logs audit trails for device profiles, which are records of 
interest.
The Bravo profile is referenced by a VWorks device file. The VWorks device file must be 
open before you can create or modify a profile. The following procedure assumes that 
you are familiar with creating and modifying Bravo profiles. For detailed instructions on 
how to create a device file containing a Bravo device and how to create a Bravo profile, 
see the Bravo Platform User Guide.

Configuring ODTC in Bravo profile

To configure the ODTC in a Bravo profile:
1 In Bravo Diagnostics, click the Profiles tab and select the Bravo profile that you 

want to use to control the ODTC.

2 Click the Configuration tab, and select Location 2.
3 In the Location is configured as list, select Accessory. 
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The Bravo Accessories Wizard opens.
4 In the Location for accessory list, verify that location 2 is selected, and then click 

Next.

5 In the Accessory list, select On-Deck Thermal Cycler, and then click Next.
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6 In the Set Accessory Parameters page, set the following parameters.

Parameter Description
XMLRPC server 
IP Address

The IP Address used by the SiLA XMLRPC Server, which is 
typically installed on the same computer as the VWorks 
software. 
Default: 127.0.0.1
Note: The default is a pseudo name for Localhost. This IP 
address allows the computer to connect to and communicate 
with itself.
Note: This is not the IP address for the ODTC accessory, 
which has its own static IP address.

XMLRPC server 
port (1–65535)

The TCP port for the SiLA XMLRPC Server. This value must 
match the corresponding value in the SiLA XMLRPC Server.
Range: 1–65535
Default: 6000

Max Z range 
needed  
(0–200 mm)

The value (mm) for the Bravo head’s lowest point of travel 
along the z-axis.
The ODTC plate stage sits lower in the Bravo deck than a 
standard platepad. To enable 250 µL pipette tips to reach the 
bottom of the wells in a microplate, the head must go down 
lower than the normal setting of 150. The default value, 154, 
for the ODTC is sufficient in most cases.
Range: 0–200
Practical range: 150–160 (standard Bravo Platform)
Default: 154
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Min Y range 
needed  
(-5–10 mm)

The value (mm) for the Bravo head’s lowest point of travel 
along the y-axis.
The ODTC plate stage extends further back on the Bravo deck 
than a standard platepad. To correctly teach this deck 
position, the pipette tip must be centered over the teaching jig 
crosshairs. In some cases, the Min Y range may need to be 
smaller than the default 0.5 mm. 
Range: -5 to 10
Practical range: -5–0.5 (standard Bravo Platform)
Default: 0.5

Teachpoint Z 
offset (-25 - -3)

The distance between the values of the following z-axis 
coordinates:
• ODTC teachpoint that is set using the teach plate
• Bottom of a PCR plate resting on the ODTC mount
In general, you should start with the default value. 
If your find that the PCR plates are not firmly seated on the 
ODTC mount when placed there by the Bravo gripper, you can 
adjust this value. The more negative the value, the lower the 
plate will be positioned on the ODTC mount.
Range: -25 to -3
Default: -18.91 mm

Parameter Description
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Click Next.
                                                        

Retrieve 
method names 
during 
initialization

The option to populate the Method name drop-down list of the 
VWorks ODTC tasks with the method names retrieved from 
the ODTC accessory.
Options:
• Yes. VWorks will re-read the method names each time the 

profile is initialized, which causes initialization to take a 
little longer. The retrieved names will be available for 
selection in the VWorks ODTC tasks.

• No. Initialization will be faster, but the method names will 
not appear in the VWorks ODTC task parameters. The 
following figure shows an example of a task without the 
method names listed.
However, if your method names are already specified in 
the VWorks protocol, and you do not intend to change 
them or write any new protocols, you can save a few 
seconds during initialization by selecting No.

Alternatively, you can use a variable or enter the exact 
method name for the Method name parameter in the 
task. 
Another option is to use the Re-read method names from 
accessory control in the ODTC Diagnostics dialog box to 
retrieve the list of method names for the current VWorks 
session. But when you reinitialize the profile, any method 
names retrieved using this option are erased. For details, 
see “Testing Bravo ODTC” on page 34. 

Default: Yes

Parameter Description
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7 In the Summary page, click Finish.

8 In the message that appears, click one of the following:

                                                        

Option Description
Yes Moves the teachpoint for this deck location to a safe height (z-axis 

coordinate).
Increases the lowest point of travel on the z-axis to 154 mm, which 
is lower than the head can travel at other deck locations.
Typically, you would select Yes.
Note: After changing the maximum z-axis range, it cannot be reset 
in this profile at this location using the Configuration tab. An 
Agilent field service engineer can use the Direct Profile Edit Utility 
to reset the value.

No Does not move the teachpoint to a safe height, and does not 
change the value of the Max Z range needed parameter.
Note: In a new profile, the Max Z range needed parameter defaults 
to 150. 
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9 In the Profiles tab, click Update this profile.

10 VWorks Plus only. If an audit trail is being logged, the Audit Comment dialog box 
opens. Select or type the audit comment, and then click OK.
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Initializing the profile

Initializing the profile establishes communication with the Bravo Platform and 
accessories. This topic describes how to initialize the profile in Bravo Diagnostics.

Before you start

WARNING
When you initialize the Bravo Platform, the head and tie bar can move. To prevent 
potential injury, keep clear of the device while it is in motion.

Ensure the following:
• The Bravo front panel status lights are blue.
• The light on the front of the ODTC is lit green, not flashing green.This light is located 

below the deck. 
When the ODTC is powered on, its indicator light flashes green for up to a minute 
while the ODTC firmware is booting. The ODTC cannot respond to any 
communication attempts, including initialization, until a few seconds after this 
green light stops flashing.

Initializing the profile in Bravo Diagnostics

To initialize the profile in Bravo Diagnostics:
1 In the Profiles tab, select the profile from the Profile name list.
2 Click Initialize this profile to start initializing the selected profile.
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Setting the teachpoint

About this topic

This topic describes how to set the teachpoint for the ODTC deck location on the Bravo 
Platform. For instructions on how to set the teachpoints at the other eight deck 
locations, see the Bravo Platform User Guide.

Before you start

WARNING
To avoid potential injury and damage to the device, only personnel trained in how to 
teach the Bravo Platform should perform the procedures in this topic. 

WARNING
The red Stop motors button in Bravo Diagnostics does not perform an immediate 
stop. The Bravo head can continue to move in the same direction at the same speed 
after you click the button. To perform an emergency stop, press the red button on the 
emergency-stop pendant.

CAUTION
Be careful not to damage or break off the small tube in the ODTC plate mount (VCM), 
as this will lead to complete loss of the VCM performance.

Figure Location of small tube in the ODTC plate mount (top view)
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Make sure you do the following:
• Remove all labware from the Bravo deck locations.
• Verify that the correct liquid-handling head is installed and the corresponding 

profile is initialized.
• Ensure you have the required resources listed in the following table.

To set the teachpoint for the Bravo ODTC:
1 Ensure that the ODTC door is open, as the following figure shows. 

• If the door is open, go to step 3.
• If the door is closed, continue to step 2.

                                                        

Required resource Description

Pipette tip for teaching Ensure the tip is the correct teaching tip for the liquid-handling head, for 
example, use a 250-µL pipette tip for the 96LT head.
Ensure that the pipette tip is new and in good condition.

feeler gauge, 0.010-inch 
(0.254 mm) 

This gauge is used to set the vertical distance between the pipette tip and 
top of the crosshairs mark on the platepad or accessory.

ODTC teach plate The teach plate is a teaching jig with a crosshairs mark in one corner.
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2 To open the door using Diagnostics, click the Configuration tab, select the On-Deck 
Thermal Cycler icon, and then click Diagnose accessory.

a In the On-Deck Thermal Cycler Diagnostics dialog box, click Open Door.
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3 Place the teach plate on the ODTC plate mount. Ensure that the crosshairs mark is 
oriented toward the left-rear corner of the Bravo deck.

The teach plate has 4 nubs on the bottom that fit into the 4 corner holes in the 
ODTC mount, which positions the teach plate precisely.

4 In Bravo Diagnostics, click the Jog/Teach tab, and select Location 2.
5 In the Approach height above teachpoint box, select 50, and then click Approach.

The Bravo head moves to deck location 2 and moves down so that the pipette tip is 
approximately 50 mm above the crosshairs on the teaching plate. 

6 Carefully, use the Jog Axes Down +Z control to move the pipette tips down until the 
pipette tip is 1–2 mm from the crosshairs, and then use the Jog Axes X/Y controls 
to center the A1 tip above the crosshairs.

7 When the A1 tip is perfectly centered above the crosshairs, set the Down +Z 
increment to 0.1 mm. Carefully, jog the head down in 0.1-mm increments just until 
a 0.254-mm (0.010-inch) feeler gauge cannot fit under the pipette tip.
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Raise the head by 0.05-mm increments until you reach the lowest possible height 
that allows the feeler gauge to slide under the pipette tip without deflecting it. 

8 Click Teach to set the new teachpoint.
The ODTC plugin automatically calculates the conversion between the teachpoint 
Z coordinate and the Z coordinate of the bottom of the teach plate.

9 Click Move to safe height at current X/Y position, and then remove the teach plate 
from the ODTC. 

10 To save the new teachpoint for this location, click the Profiles tab, and then click 
Update this profile.

11 VWorks Plus only. If an audit trail is being logged, select or type a comment in Audit 
Comment dialog box, and then click OK.
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Testing Bravo ODTC

Before you start

IMPORTANT
Make sure that you initialize the profile you are testing immediately before testing the 
communication with the accessory.

Ensure that the SiLA XMLRPC Server is on to enable communication with the Bravo 
ODTC.

Procedure

To test the communication with the ODTC:
1 In Bravo Diagnostics, click the Configuration tab.
2 In the Accessory Configuration pane, click the On-Deck Thermal Cycler icon, and then 

click Diagnose accessory.

The Agilent Bravo Accessory Diagnostics dialog opens and display the On-Deck 
Thermal Cycler controls.
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3 Use the following controls and indicators as appropriate.

Controls and 
indicators

Description

Open Door Horizontally slides the ODTC door (lid) open.

Close Door Horizontally slides the ODTC door closed.
Read Actual 
Temperature

Opens a Sensor Values dialog box that displays the 
temperature reading.

Re-read method 
names from 
accessory

Retrieves the names of the pre-methods and methods that 
have been uploaded to the Bravo ODTC.

Method name Specifies the method name that you want to run.
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Priority Specifies the priority for the selected method:
• Standard. Select this option for a method or a pre-

method.
• Finish after 40 seconds. If a pre-method is specified, you 

can select this option.
Execute Method Runs the selected method on the ODTC.
Stop Method Stops the running method and any post-method 

temperature control in progress on the ODTC. 
Note: If the method finishes executing but the ODTC fan is 
still running, a post-method temperature control is in 
progress.

Controls and 
indicators

Description
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Setting the labware class 

ODTC labware class

The VWorks software includes the following labware class to specify the allowable 
labware on the ODTC at Bravo deck location 2: 
Uses Thermal Cycler Platepad
This labware class includes the labware entries for the compatible labware listed in 
“Labware requirements” on page 10. The Uses Thermal Cycler Platepad labware class 
should be the only one allowed to use the ODTC at deck location 2. All other labware 
classes are prohibited at this location.
Use the following procedure to set the labware class for the ODTC accessory at Bravo 
deck location 2 in the VWorks device file. 

Setting the allowable labware class for deck location 2

The following procedure assumes that you have already created a VWorks device file 
that contains a Bravo device. If you have not yet created a device file, see the Bravo 
Platform User Guide for instructions.

To set the labware class for deck location 2:
1 In the VWorks window, open the device file that includes the Bravo device.
2 Ensure the correct profile with the configured ODTC accessory is selected for the 

Bravo device.
3 In the Devices pane, expand the device icon, and select location 2 to display the 

location properties.

4 In the Allowed/prohibited labware field, click the browse button .
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The Allowed/Prohibited Labware Classes dialog box opens for the selected 
location.

5 In the center pane, click Uses Thermal Cycler Platepad, and then click  to move 
this labware class to the right pane.

6 In the right pane, click Uses Standard Platepad, then click  to move this labware 
class left to the center pane.
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7 Ensure that Uses Thermal Cycler Platepad is the only labware class remaining in the 
Labware classes allowed to use this device pane, and then click OK.

8 Click File > Save to save the changes to the device file.
9 VWorks Plus only. If an audit trail is being logged, the Audit Comment dialog box 

opens. Select or type the audit comment, and then click OK.
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3 ODTC protocol tasks
This chapter describes the VWorks protocol tasks that run the preloaded ODTC 
methods. The topics are:
• “ODTC Action (Agilent Bravo)” on page 42
• “ODTC Run Method (Agilent Bravo)” on page 46
For instructions on how to create a VWorks protocol, see the VWorks Automation 
Control User Guide. 
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ODTC Action (Agilent Bravo)

Description

The ODTC Action (Agilent Bravo) ( ) task runs Bravo ODTC pre-
methods or methods before labware is mounted on the accessory. For example, some 
protocols require the ODTC to be preheated or chilled to a specific temperature before 
running a method with labware mounted on the device. 
Note: You can add multiples of this task in the protocol to create an action list

Requirements

Ensure the following:
• The VWorks device file you are using includes a Bravo device associated with a 

profile configured for the ODTC accessory.
• The relevant ODTC pre-methods and methods are preloaded on the ODTC 

accessory. 

Task parameters

After adding the ODTC Action task at the desired point in the protocol, set the following 
parameters in the Task Parameters area:

Task is available for... Task is available in...

Bravo Platform Startup Protocol
Main Protocol, Bravo Subprocess
Cleanup Protocol
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Parameter Description

Location Select location 2, which is where the ODTC is installed in the Bravo deck.
Note: If the task is in a Bravo subprocess, the Bravo device specified by the 
Subprocess task is used. If the task is in the Startup or Cleanup protocol, the Task 
Parameters pane Device Selection specifies which Bravo to use.

Step 1 Select one of the following actions to perform as the first step in this task. 
Note: The temperature control action only applies if the method specifies post-
method temperature control and no method is running.
• Stop any running method, but don’t interrupt temperature control. Stops any 

previously launched method that is still running. 
• Wait for any running method to finish and don’t interrupt temperature control. If a 

method is running, the software will wait the specified time limit to allow the 
method to finish. Also, specify the Time limit for previous method parameter.

• Stop any running method and temperature control. Stops any method in progress, 
and stops any post-method temperature control in progress.

Time limit for previous 
method (0 - 172800 s)

Available only if Wait for any running method to finish and don’t interrupt temperature 
control is selected.
Enter the number of seconds to allow for any running method to finish. If this value is 
greater than 0, the software will wait for the specified number of seconds. 
If the time limit is reached and the method is still running, the method will be stopped 
if the Stop previous method after time limit parameter is selected. 
Note: An error will occur if Stop previous method after time limit is not selected.

Stop previous method 
after time limit

Available only if Wait for any running method to finish and don’t interrupt temperature 
control is selected.
Select the check box to stop the method after the specified time limit.
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Step 2 Select one of the following ODTC door operations to run after Step 1 completes:
• Leave door as-is
• Close door
• Open door

Step 3 Select the last action to perform during this task:
• Start a method. This option allows concurrent operation. The specified method is 

started on the ODTC, the ODTC Action task ends, and the software proceeds on 
to the next task in the protocol while the specified ODTC method continues to 
run. 
Also specify the parameters for Method name, Priority, and Prevent access to 
location while method is running.

• Do nothing else. Ends the ODTC Action task after Step 2.
• Run a method and wait for it to finish. Runs the specified method and allows it to 

finish before the ODTC Action task ends. 
Also specify the parameters for Method name, Priority, and Prevent access to 
location while method is running.

Method name Available only if the Step 3 action starts or runs a method. 
Specify the name of the method by doing one of the following:
• Select from a list of method names. 

Note: The list of method names appears here only if the Retrieve method 
names during initialization is specified in the profile configuration for the ODTC 
or if the Re-read method names from accessory control is used in the ODTC 
Diagnostics dialog box. 

• Use a JavaScript variable to specify the method name. For details on using 
JavaScript variables, see the Using simple variables topic in the VWorks 
Automation Control User Guide.

• Enter the exact name of the method you want to run (case sensitive).

Priority Select the appropriate priority for the specified method: 
• Standard
• Finish after 40 seconds
Pre-Methods can be run using either priority. Regular methods should only be run 
with a priority of Standard.

Time limit  
(0 - 172800 s)

Available only if the Step 3 action specifies Run a method and wait for it to finish. 
Enter the number of seconds to allow for the method to finish:
• If the value is greater than 0, the task will only wait for the number of seconds 

specified. 
• A value of 0 or blank results in no time limit.
Note: An error message displays if the method has not finished by the specified time 
limit. 

Parameter Description
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Related information

Prevent access to 
location while method 
is running

Select this check box to prevent the Bravo from picking or placing labware at the 
ODTC while the method is running. 
Clear this check box to allow the Bravo to pick or place labware at the ODTC while the 
method is running. 
Note: While a method is running you cannot open or close the ODTC door.
Note: If VWorks schedules a pick or place at the ODTC location while the ODTC door 
is closed, the method is prematurely interrupted so that the ODTC door can be 
opened.

Parameter Description

For information about... See...

Creating protocols VWorks Automation Control User Guide
VWorks Protocol Authors Quick Guide

Displaying the ODTC method names 
in the VWorks task

“Configuring ODTC in Bravo profile” on 
page 21
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ODTC Run Method (Agilent Bravo)

Description

The ODTC Run Method (Agilent Bravo) ( ) task runs a method 
while the appropriate labware is mounted on the ODTC accessory. 

Requirements

Ensure that the following requirements are met:
• The device file associated with the protocol includes a Bravo profile with a 

configured ODTC accessory. See “Configuring Bravo ODTC accessory” on page 21.
• The relevant ODTC methods have been preloaded on the ODTC accessory.
• ODTC-compatible labware is used for the task. See “Labware requirements” on 

page 10.

Task parameters

After adding the ODTC Run Method task at the desired point in the protocol, set the 
following parameters in the Task Parameters area:

Task is available for... Task is available in...

Bravo Platform Main Protocol, Bravo Subprocess
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Parameter Description

Location, Plate Select the process or static labware involved in the task. 
Ensure that the specified labware meets the requirements for the Bravo ODTC. 

Location Use <auto-select> or select location 2, which is the ODTC deck location.

Wait for previous 
method to finish

If you want the task to wait for any currently running method to complete before 
starting, select the check box and specify the Time limit for previous method 
parameter. 
To automatically stop any currently running method when the task starts, clear the 
check box.

Time limit for previous 
method (0 - 172800 s)

Specify the time (seconds) to allow any currently running method to finish before 
starting this task. 
• If the value is greater than 0, the task will only wait for the number of seconds 

specified. 
• A value of 0 or blank results in no time limit.
Note: An error message displays if the method has not finished by the specified time 
limit. 

Method name Specify the name of the method by doing one of the following:
• Select from a list of method names. 

Note: The list of method names appears here only if the Retrieve method 
names during initialization is specified in the profile configuration for the ODTC 
or if the Re-read method names from accessory control is used in the ODTC 
Diagnostics dialog box. 

• Use a JavaScript variable to specify the method name. For details on using 
JavaScript variables, see the Using simple variables topic in the VWorks 
Automation Control User Guide.

• Enter the exact name of the method you want to run (case sensitive).

Close door during 
method run

Specify the position of the ODTC door while the method is running:
• Select the check box to automatically close the ODTC door before the method 

starts. 
If the Open door when finished check box is also selected, the door will open 
when the method (not pre-method) ends. If you also select Allow concurrent 
operation, the method must finish before the door opens.

• Clear the check box if the door should remain open during the thermal cycling 
method, for example, if you are doing a concurrent operation at this location.

Open door when 
finished

Specify the position of the ODTC door when the method is finished:
• Select the check box to automatically open the ODTC door after the method (not 

pre-method) ends, for example, if a Mix task occurs next at the ODTC location.
• Clear this check box to leave the ODTC door closed after the method ends.
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Related information

Allow concurrent 
operation

Select this check box if you want the method and pre-method, if specified, to run 
while the protocol proceeds on to the next task in the subprocess. The moment after 
the labware is placed at the ODTC, the ODTC Run Method task ends, but the 
specified method continues to run in the background. 
For example, you could run a pipetting task at the ODTC deck location while a 
thermal cycling method is running.
Clear this check box if you want the ODTC Run Method task to continue to run until 
the method finishes before starting another task in the subprocess.

Parameter Description

For information about... See...

Creating protocols VWorks Automation Control User Guide
VWorks Protocol Authors Quick Guide

Displaying the ODTC method names 
in the VWorks task

“Configuring ODTC in Bravo profile” on 
page 21

Labware compatible with Bravo ODTC “Labware requirements” on page 10
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4 Maintenance and troubleshooting
This chapter contains the following topics:
• “Routine maintenance” on page 50
• “ODTC troubleshooting guidelines” on page 51
• “Reporting problems” on page 53
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Routine maintenance

Before you start

WARNING
To prevent potential injury, always turn off power to the Bravo Platform and the OTC 
device before performing any maintenance procedure.

To access the ODTC plate mount for cleaning, follow the instructions in the Inheco 
ODTC User and Installation Manual to manually open the ODTC door to the vertical 
position.
Agilent Technical Support is your primary contact if you have a problem with the Bravo 
ODTC accessory that you cannot resolve. See “Reporting problems” on page 53 for 
instructions on contacting Agilent Technical Support. 

Cleaning up spills and periodic cleaning

CAUTION
Use only the recommended cleaning materials. Using other cleaning solutions and 
materials can cause damage to the device. Do not use aggressive cleaning fluids 
such as acetone, or abrasive cleaners. The nickel teflon coating of the ODTC VCM 
(plate mount) and coatings of other components could be damaged.

CAUTION
Ensure that no liquids enter into the ODTC or Power & Control Unit.

Keep the area under and behind the Bravo deck clean and free of obstacles. The 
ventilation inlets on the Power & Control Unit and ODTC should be checked for 
contamination and should be cleaned if necessary. 
The ODTC contact surfaces should be cleaned regularly to ensure optimum heat 
transfer to the PCR plate. Always clean the contact surface after a spillage.
Use a clean, soft cloth with a 50:50 water/isopropanol solution and make sure that no 
deposits are left on the surface.
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ODTC troubleshooting guidelines

Agilent Technical Support is your primary contact if you have a problem with the Bravo 
ODTC accessory that you cannot resolve. See “Reporting problems” on page 53 for 
instructions on contacting Agilent Technical Support. 

Troubleshooting problems

This table lists some potential hardware and communication problems that you might 
encounter when using the Bravo ODTC. If you encounter a problem, locate the problem 
under one of the following categories, and try the recommended solution to resolve the 
problem.

Problem Possible cause Solution

The Bravo ODTC does not 
turn on.

The device electrical requirements 
are not met.

Ensure that the site meets all the 
electrical requirements for the Bravo 
Platform. See the G5562A, G5563A 
Bravo Platform Safety and Installation 
Guide.
Turn on the ODTC Power & Control Unit 
(PCU) power switch.

The ODTC is not connected to the 
Power & Control Unit (PCU), or the 
PCU is not connected to a power 
source.

Inspect the power cords and 
connections and ensure that you are 
using the Agilent-supplied country-
specific power cord. Turn on the ODTC 
PCU power switch.

The ODTC does not initialize 
when the Bravo profile is 
initialized.

The ODTC was not fully booted 
when the Bravo profile was 
initialized.

When the ODTC is powered on, its 
indicator light flashes green for up to a 
minute while the ODTC firmware is 
booting. Wait for a few seconds after 
this green light stops flashing before 
attempting to initialize the Bravo profile.

The SiLA XMLRPC Server is not 
running.

The SiLA XMLRPC Server must be 
running to enable VWorks 
communication with the Bravo ODTC 
device. 
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The ODTC door (lid) 
malfunctions.

An object is blocking the door or 
incompatible labware is being 
used on the ODTC.

Ensure the following;
• An object is not blocking the door.
• You are using only approved 

labware at the ODTC. See “Labware 
requirements” on page 10.

The PCR plate is sitting too high 
on the ODTC plate mount.

Determine if the door has clearance 
when the labware is on the plate mount. 
If necessary, reconfigure the accessory 
in the Bravo profile and adjust the 
Teachpoint Z offset value. See 
“Configuring ODTC in Bravo profile” on 
page 21.

The ODTC Sealing Cover is 
installed in the door but has 
dismounted or requires 
replacement.

See the Inheco ODTC User and 
Installation Manual for instructions.

PCR plates are not firmly 
seated on the ODTC mount 
when placed there by the 
Bravo gripper.

Incompatible labware is being 
used on the ODTC.

Use only approved labware at the ODTC. 
See “Labware requirements” on 
page 10.
If necessary, reconfigure the accessory 
in the Bravo profile and adjust the 
Teachpoint Z offset value. See 
“Configuring ODTC in Bravo profile” on 
page 21.

Labware is stuck in the ODTC 
plate mount.

Incompatible labware is being 
used on the ODTC.

Use only approved labware at the ODTC. 
See “Labware requirements” on 
page 10.
If you need to replace the plate ejection 
bars, see Inheco ODTC User and 
Installation Manual for instructions.

ODTC is overheating or has 
fan issues.

An object or objects are blocking 
the free air flow at the ODTC 
ventilation inlet or outlet.

Ensure that the area below the Bravo 
deck is clear of any obstacles that could 
restrict the ODTC airflow. 
Do not cover the ODTC ventilation inlet 
at the front or the exhaust outlet 
underneath the unit at any time. Keep 
the air inlet clean. See “Bravo ODTC 
components” on page 5.

ODTC Power & Control Unit is 
overheating.

An object or objects are blocking 
the free air flow at the PCU 
ventilation inlet or outlet.

Ensure enough free space in front and 
back of the PCU. Keep the air inlets 
clean on the front of the PCU. See 
“ODTC Power & Control Unit” on page 7.

Problem Possible cause Solution
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Getting ODTC status and error information

The Inheco ODTC Device Manager User’s Manual describes how to use the ODTC 
Device Manager software for 
• IP settings
• Downloading log and trace files from the ODTC for support

These files contain status and error information for troubleshooting problems with 
the ODTC.

• Malfunctions and error messages

Inheco ODTC support pages

Product support information for the ODTC is posted in the Inheco web pages at 
https://www.inheco.com/
After registering to use the web pages, you can access the following: 
Product Support > ODTC > Knowledge Base and Errors List

Reporting problems

This topic describes for how to report hardware, software, and user guide problems.

Contacting technical support

If you find a problem with the VWorks software, contact Agilent Technical Support. For 
contact information, go to https://www.agilent.com/en-us/contact-us/page.
Note: You can also send a software bug report from within the VWorks software.

Reporting hardware problems

When contacting Agilent Technical Support, make sure you have the serial number of 
the device or workstation ready. See the device user guide for the location of the label.

Reporting software problems

When you contact Agilent Technical Support, make sure you provide the following:
• Short description of the problem

• Software version number
• Error message text (or screen capture of the error message dialog box)
• Screen capture of the About VWorks software dialog box
• Relevant software files

To find the VWorks software version number:
In the VWorks software, select Help > About VWorks.

To find the Diagnostics software version number:
1 Open Diagnostics.

https://www.agilent.com/en-us/contact-us/page
https://www.inheco.com/
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2 Read the version number on the title bar of the diagnostics window.

To send compressed protocol and associated files in VZP format:
In the VWorks software, select File > Export to export and compress the following files:
• Protocol file
• Device file (includes the device profile and teachpoint file)
• Labware definitions
• Liquid classes
• Pipette techniques
• Hit-picking files
• Plate map files
• Barcode files
• Error library
• Log files
• Form file (*.VWForm)

Reporting user guide problems

If you find a problem with this user guide or have suggestions for improvement, send an 
email to documentation.automation@agilent.com.
 

mailto:documentation.automation@agilent.com
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